OS MasterMap Topography Layer - Building Height Attribute

v1.1
Preface

Purpose and disclaimer

This getting started guide is provided for guidance only and does not constitute any warranty, representation, undertaking, commitment or obligation (express or implied) about the product or its suitability for any particular or intended purpose. Any warranties, representations, undertakings, commitments and obligations given by Ordnance Survey about the product and/or its suitability for any particular or intended purpose are set out in your customer contract. It is your responsibility to ensure that this product is suitable for your intended purpose.

Ordnance Survey does not accept any liability (whether for breach of contract, negligence or otherwise) for any loss or liability you or any third party may suffer in relying on this guide and any guidance, suggestion, advice or explanation provided in it. Any liability that Ordnance Survey has to you in relation to the product, its supply, use, accuracy, data supplied, functionality or any other liability arising out of or in connection with the product is limited as set out in your customer contract.

We may change the information in this guide at any time without notice.

We do not accept responsibility for the content of any third party websites referenced or accessed.

Data copyright and other intellectual property rights

The Crown (or, where applicable, Ordnance Survey’s suppliers) owns the intellectual property rights in Ordnance Survey digital map data.

Full details of the terms and conditions under which Ordnance Survey digital map data may be processed and/or manipulated or copied by a customer—whether or not for use on PCs or workstations or for making hard copies—are available from the Customer Service Centre, please see Further information. You should check the terms and conditions with us before using the data. It is also the responsibility of the holder of the digital map data to ensure that any plotted or printed output contains the required copyright and database acknowledgements in a conspicuous position.
1 Purpose

OS MasterMap® Topography Layer – Building Height Attribute is an enhancement to the OS MasterMap Topography Layer. The enhancement is being supplied as a comma delimited (.csv) format and is being supplied separately from the OS MasterMap Topography Layer’s Geographic Mark-up Language (GML) data files. Therefore these two files will need to be joined in order to use the Building Height Attribute data. Building Height Data has not been included as part of the Topography Layer as it is still in a Beta development stage. To provide this data as a separate .csv file requires no schema change.

This Getting Started Guide is designed to walk you through the steps you need to take to join the Building Height Attribute data with OS MasterMap Topography Layer within a GIS and how to load the data into a database.

Firstly, you will need to check the format of your TOIDs in your translated OS MasterMap Topography Layer and compare it to the format of TOID in the Building Height Attribute data. The format of the TOIDs needs to be the same so that the data can be joined with OS MasterMap Topography Layer. The steps on how to do this can be found in Chapter 5.

If you will be using the data in a GIS, you will then need to load the Building Height Attribute Data into your GIS and join it with the OS MasterMap Topography Layer. The steps on how to do this can be found in Chapter 6 and Chapter 7.

If you will be using the Building Height Attribute data in a database environment then the data will need to be imported into a database and the steps on how to do this can be found in Chapter 8.
2 Applications

OS MasterMap® Topography Layer – Building Height Attribute provides a set of additional attributes that enhances and forms part of the OS MasterMap Topography Layer. This building height attribution can be used to make simple 3D visualizations and is an important variable in a range of analytical applications.

Examples of the way you can use building height attribution in your business are:

► to visualize urban landscapes, to inform planning decisions and to aid the formulation and communication of planning policy;
► to model the impact of development projects quicker and with increased efficiency;
► to help in emergency planning and risk assessment, by allowing the appropriate resources to be deployed more rapidly;
► to help understand the issues with installing and maintaining utilities and services to customers, for example, water and gas pressure calculations, smart meters;
► to use in insurance calculation models, through using the heights as a proxy for number of levels in a building;
► to use in calculations of radio signal propagation and the planning of wireless networks; and
► to identify appropriate sites of renewable energy infrastructures.

A map of the coverage available is on the Useful Links section of the Topography Layer support page on the Ordnance Survey website:

There is more information on this attribution in the User Guide and Technical Specification document:
3 What do I need to use this data?

3.1 System requirements

OS MasterMap Topography Layer – Building Height Attribute is designed to be joined to and then used as part of the OSMasterMapTopographyLayer. Chapter 7 gives guidance on how to join this data to your Topography Layer holding.

As it is a part of the OS MasterMap Topography Layer, Building Height Attribute is designed for use in a digital map within geographical information systems (GIS) and database systems. For details of Ordnance Survey’s Licensed Partners who can assist you with incorporating Building Height Attribute in their systems, please see the systems/software page on the Ordnance Survey website.

Ordnance Survey does not recommend either suppliers or software products, as the most appropriate system will depend on many factors, such as the amount of data being taken, resources available within the organization, the existing and planned information technology infrastructure and last but by no means least, the applications that the data will be used for.

However, as a minimum, the following elements will be required in any system:

- a means of reading the data, either in its native format, or by translating it into a file format or for storage in a database;
- a means of storing and distributing the data, perhaps in a database or through a web-based service; and
- a way of visualizing and/or querying the data, typically a GIS.

3.2 Backup provision of the product

You are advised to copy the supplied data to a backup medium before following the steps in this Guide.

3.3 Typical data volumes

For reading purposes it is recommended that users store the data on a single hard disc. This will speed up the ability of your computer to read the data. Uncompressed file sizes for the full supply of England and Wales are as follows:

3.3.1 Uncompressed comma-separated values (CSV) (for GB)

The uncompressed file size for the full release is 2.3 Gb.
4 Structure of the supplied data

4.1 Data structure

In order to allow customers to receive OS MasterMap Topography Layer – Building Height Attribute as soon as possible, we are providing this data in a comma delimited (.csv) format.

4.2 Ordering

BHA can be ordered from OS Orders.
5 Managing the CSV data

The Building Height Attribute .csv contains the attribute OS_TOPO_TOID, which is the TOID from Topography Layer. This TOID is the attribute that is used to join the data to your Topography Layer data. More information about TOIDs is available in the OS MasterMap Topography Layer user guide and technical specification.

5.1 Checking TOIDs

TOIDs are stored in GML as a character string, with the prefix 'osgb', and can comprise of either a 13-digit number or a 16-digit number after ‘osgb’ (for example, osgb1 000001 799480255), Ordnance Survey recommends that TOIDs are stored in this format.

Some of the methods available to translate Topography Layer from GML alter the TOID from the format in which it is supplied in the GML. We have tested a small sample of these to ascertain how the TOID is dealt with during some translation processes.

Below is a table showing how some translators we tested deal with TOIDs; please look at your own data to investigate how your translation process has affected the TOIDs in your data.

<table>
<thead>
<tr>
<th>Translator</th>
<th>Processing of TOID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Esri UK Productivity Suite</td>
<td>Removes ‘osgb’ from the beginning of TOID</td>
</tr>
<tr>
<td>Miso InterpOSe</td>
<td>Removes ‘osgb’ and adds three leading zeroes to 13-digit TOIDs</td>
</tr>
<tr>
<td>Astun Loader</td>
<td>Preserves raw GML TOID format but renames column from TOID to fid</td>
</tr>
<tr>
<td>Pitney Bowes MapInfo</td>
<td>Removes ‘osgb’ from the beginning of TOID</td>
</tr>
<tr>
<td>QGIS</td>
<td>Preserves raw GML TOID format</td>
</tr>
</tbody>
</table>

It is recommended that the OS_TOPO_TOID attribute in the Building Height Attribute .csv files be edited, if it is found that the OS MasterMap Topography Layer TOID has been altered during the translation process, although how TOIDs are managed is up to your discretion. To aid this process we have created some script that can be run alongside a gawk application that will alter TOIDs in the csv files in two different ways. It is recommended that you create a backup copy of your csv file before you make any changes to it.

5.2 Databases

If your TOID column requires altering, steps are outlined in Chapter 8 detailing how this can be achieved in a database environment. This can also be achieved using the gawk process outlined below.
5.3 Reformatting the TOID Attribute

There are several options which will allow the user to reformat the TOID attribute to be able to join it with the TOID field in OS MasterMap Topography layer. For smaller amounts of data, the simplest option is to use the free open source text editor called Notepad++. Using this text editor, simply load up the building heights .csv data and then, using the search and replace option, simply replace the osgb part of the TOID name and replace it either with nothing or three leading zeroes. Remember to save the file as a new name once procedure this has been carried out.

The following section details other steps that you can take to reformat the TOID attribute in the Building Height Attribute (BHA).csv, so that the format matches that of the TOID attribute in your translated OS MasterMap Topography Layer, Topographic Area data. The reformatting of TOID is a very quick option which will take 5minutes to set up and process on a national set of data for Building Height Attribute.

Please note: if the format of the TOIDs in your translated Topography Layer data match that in the BHA .csv, please skip to Chapter 6.

Two script reformatting options are presented below:

1. **Script to remove ‘osgb’ from BHA TOIDs:**
   Recommended for use if your translator removes ‘osgb’ from your Topography Layer TOIDs but does not add any leading zeroes to shorter 13-digit TOIDs.

2. **Script to remove ‘osgb’ and add ‘000’ to 13-digit BHA TOIDs:**
   Recommended for use if your translator removes ‘osgb’ from your Topography Layer TOIDs and adds three leading zeroes to shorter 13-digit TOIDs.

In order to use either reformatting fix you will need to download gawk, a tool that uses pattern-matching principles to do simple data re-formatting tasks (available at https://code.google.com/p/gnu-on-windows/downloads/detail?name=gawk-4.0.2-bin.zip&can=2&q).

Download this tool and save the zip file in any location. Extract the ‘gawk.exe’ file to a directory containing the BHA csv file you wish to alter (this must contain only the csv to alter and no other files). There must be no spaces in the entire file path to that directory as this will cause the process to fail.
Both reformatting processes require you to create an .awk file and .bat file alongside the gawk application. These need to be saved in the same directory as the gawk application and BHA csv you wish to alter. The structure of the .awk file specified below remains unchanged regardless of whether you are using reformatting option 1 or 2. Unlike the .awk file, the content of the .bat file is different for both reformatting options. The format to use in both instances is described after the .awk file detail below.

5.3.1 Generating the .awk file

Copy and paste the following code into a new text editor document (such as Notepad):

```bash
# COMMAND LINE gawk -v leadingZeroes=TRUE|FALSE -f bha_fixTOID.awk infile > outfile

BEGIN {
    FS = ",";
    OFS = ",";
}

{ {
    sub("osgb","",$1)
    if (leadingZeroes == "TRUE")
        $1 = sprintf("%016s",$1)
    print
}

Save the file as ‘bha_fixTOID.awk’ in the same directory as the gawk application and BHA csv file.

Please note: this code refers to the file name of this .awk file. If you choose to name your .awk file differently to our suggested name, please change the code to reflect the name of the .awk file you are using.
5.3.2 Generating the .bat file

1  Script to remove ‘osgb’ from TOIDs:

If using this reformatting option please copy the following text into a new text editor document and save the document with a .bat extension in the same directory as the gawk application, .awk file and csv file:

```bash
@rem --- Line below to remove OS_TOPO_TOID "osgb" prefix only
FOR /F "tokens=*" %%A IN ('dir *.csv /s/b') DO (gawk -v leadingZeroes=FALSE -f bha_fixTOID.awk %%A > _%%~NA%%~XA)
pause exit
```

Please note: this code refers to the file name of this .awk file. If you choose to name your .awk file differently to our suggested name, please change the code to reflect the name of the .awk file you are using. The .bat file does not have to have a specific name, only the .awk file has to have a specific name because the .bat file refers to the name of the .awk file.

2  Script to remove ‘osgb’ and add ‘000’ to 13-digit BHA TOIDs:

If using this reformatting option please copy the following text into a new text editor document and save the document with a .bat extension in the same directory as the gawk application, .awk file and csv file:

```bash
@rem --- Line below to remove OS_TOPO_TOID "osgb" prefix + add leading zeroes
FOR /F "tokens=*" %%A IN ('dir *.csv /s/b') DO (gawk -v leadingZeroes=TRUE -f bha_fixTOID.awk %%A > _%%~NA%%~XA)
pause exit
```

Please note: this code refers to the file name of this .awk file. If you choose to name your .awk file differently to our suggested name, please change the code to reflect the name of the .awk file you are using. The .bat file does not have to have a specific name, only the .awk file has to have a specific name because the .bat file refers to the name of the .awk file.
5.3.3 Executing the reformatting operation

For both reformatting options, navigate to the directory where the .bat file is saved and execute it by double clicking the file. An MS-DOS window will appear.

Once the process is complete press the return key to close the window.

The directory should now contain a new BHA.csv file with the same name as the original, but starting with an underscore. This .csv will contain a copy of the original with the TOID attribute altered.

**Please note:** If you wish to check how this has altered the TOID attribute do not open it with Microsoft Excel because it will reformat the TOID and read it as a number field. Instead open the .csv file in a text editor as this will keep the TOID correctly formatted.

5.3.4 Merging CSV Files

It is likely that the user will wish to merge 5 X 5km² tiles together to create an area of interest before loading into a GI application. The following procedure can be followed to undertake this operation.

- Place all the .CSV files into an empty folder.
- Copy and paste the following script into a text editor such as Notepad, and once copied, give the file a name which explains its function. In this case we have called the file ‘MergedBHAdata.bat’

```
copy *.csv mergedBHAdata.csv
```

This script will create a new file called mergedBHAdata.csv from all the component .csv files in the folder.

- Delete the original 5 X 5km² from the folder leaving just the newly created mergedBHAdata.csv in the folder.
- Copy and paste the following script into a text editor such as Notepad, and once copied, give the file a name which explains its function. In this example, we have called the file ‘Append_BHA_Header. Bat’

```
copy BHA_Header.csv+ mergedBHAdata.csv BHA_Data.csv
```

- Place the header file for Building height data, downloaded from the OS web site product support page into the same folder as the merged BHA data file, along with the batch file that was created in the previous bullet point.
- Run the batch file. A new merged .csv file containing the header will be created called ‘BHA_Data.csv’
6 How do I load the Building Height Attribute product into a GIS?

The Building Height Attribute can be loaded into several Geographic Information Systems (GIS). This chapter describes how to load it into commonly used GIS. For more information on other GIS that the Building Height Attribute product is compatible with, please speak to your Relationship Manager.

The format of the TOIDs in your .csv may impact on how you import the .csv into a GIS. If you have not had to alter the TOID format, GIS software should read the OS_TOPO_TOID column in the .csv file as a text string automatically which should match your Topography Layer TOIDs. Therefore, you do not have to carry out any extra steps when importing your .csv file into a GIS so you may wish to move on to the next chapter.

However, if you have had to alter the OS_TOPO_TOID in the Building Height Attribute .csv by removing the 'osgb', this attribute may be read as a number by a GIS, meaning any leading zeroes added will be deleted and the TOID field in the .csv will be incompatible with the TOID field in the OS MasterMap Topography Layer data which is formatted as a text string. Therefore, we have outlined some steps which will allow the user to specify the field types for csv files being imported to some GIS environments.

The processes described below will work with individual or merged versions of the .csv data

6.1 ESRI®:

These notes outline how to load Building Height Attribute into ArcMap using the .csv file you have received and/or altered. They have been prepared using version 10.5 of ArcMap.

If you are importing an unmodified version of the .csv file then you can import this directly into ArcMap via the ‘Add Data’ button.

If you are importing a .csv with an altered OS_TOPO_TOID attribute you need to carry out the step detailed below before importing.

You can create a schema information file which describes the format of the fields contained within a text file. A schema information file is always named ‘schema.ini’ and is stored within the same directory as the csv you wish to import into ArcMap.
Please open a new text editor document and copy the following script into it;

```plaintext
[_BHA_Data.csv]
Format=CSVDelimited
ColNameHeader=True
Col1=OS_TOPO_TOID Text
Col2=OS_TOPO_VERSION Long
Col3=BHA_ProcessDate DateTime
Col4=TileRef Text
Col5=AbsHMin Double
Col6=AbsH2 Double
Col7=AbsHMax Double
Col8=RelH2 Double
Col9=RelHmax Double
Col10=BHA_Conf Long
```

Please Note: This section of code, within the square brackets, refers to the file name of the .csv you wish to import. Please alter this line to reflect the file name of your csv.

Save this in the same directory as the csv you wish to import into ArcMap, naming it ‘schema.ini’.

This file will now be read by ArcMap when you import the .csv file into it and will specify the field type for each field within the .csv file. This ensures that the TOID is treated as a text string.

### 6.2 QGIS:

These notes outline how to load Building Height Attribute into QGIS using the .csv file you have received and/or altered. They have been prepared using version 2.14.15 of QGIS Desktop.

If you are importing an unaltered .csv file which contains TOIDs in the format they are found in the raw GML then you can import this via the ‘Add Delimited Text Layer’ icon. If you wish to import this .csv via the ‘Add Vector Layer’ option you will have to create a .csvt file as outlined below or all the fields will be imported as ‘String’.

If you are importing a modified version of the .csv file you must create a .csvt file or the TOID field may be imported as a number.

A .csvt file is the equivalent of a schema.ini file for use in QGIS. It specifies the field types of a text file you are importing into QGIS.
It must be named the same as the csv file it is referring to and be stored in the same directory as the csv you wish to import into QGIS.

Please open a new text editor document and copy the following script into it:

"String","Integer","Date","String","Real","Real","Real","Real","Real","Integer"

Save this in the same directory as the .csv file you wish to import into QGIS with the same file name as the .csv file, and the file extension .csvt.

You can now import the .csv file into QGIS by selecting the ‘Add Vector Layer’ or ‘Add Delimited Text Layer’ options in QGIS and this file will now be read by QGIS during the import process and will specify the field type for each field within the .csv file.

6.3 MapInfo®:

These notes outline how to load Building Height Attribute into MapInfo using the .csv file you have received and/or altered. They have been prepared using version 16.0.0 of MapInfo (64bit version).

How you have altered the TOID field in the .csv file will affect the methodology employed when importing the .csv file into MapInfo. If you have retained the raw GML TOID format or added leading zeroes into your TOID field then MapInfo will automatically pick this up as a character field so it can be added to MapInfo in the following process:

1. Navigate to the ‘Open’ wizard either by using the icon or by clicking File>Open.
2. Select ‘Comma Delimited CSV (*.csv)’ from the ‘Files of type’ drop-down and then navigate to where the .csv file is stored.
3. Select the .csv file you wish to open and click open.
4. The ‘Open’ wizard will close and a ‘Comma Delimited CSV Information’ dialogue box will appear. Ensure the ‘Use first line for column titles’ check box is ticked and click OK to close the dialogue and open the .csv file. The TOID field should be formatted as a text string and include leading zeroes.

If you have removed ‘osgb’ but not added any leading zeroes please follow the steps outlined above. You should see that the TOIDs are formatted as numbers and contain decimal places. If you then navigate to the directory where you have stored the .csv file you should see that MapInfo has created a .TAB file with the same name as the .csv file. When this .TAB file is opened within a text editor something similar to the text below should be displayed:

Please note: the field types may vary depending on previous processing. The section of code, within the chevrons, refers to the file name of the Building Height Attribute .csv.
As you can see here the field OS_TOPO_TOID has a data type of ‘Integer’. Manually change this in the text editor to ‘Char (20);’ to specify this field type as text, and save the .TAB file before closing.

Close the original .csv file displayed in MapInfo by selecting File>Close Table.

Open the .TAB file that you just edited. The TOID field should now be formatted correctly and you can use this .TAB file to join to the OS MasterMap Topography Layer data holdings.

Please note: if you re-open the .csv file in MapInfo and choose to overwrite the table the TOID field will be formatted as a number again. Instead you should use the .TAB file rather than the .csv file.

Now you have loaded the csv file you will need to export as a .dbf (dBASE DBF) file and create an index on the TOID column in the table. To do this, follow the below steps:

1. In the ribbon toolbar, select the ‘Table’ tab and then select ‘Export’. Navigate to where you wish to save the .dbf. Ensure the ‘Save as type’ is set to ‘dBASE DBF (*.dbf)’
2. Select the 'Table tab' in the ribbon menu, then select 'Table' and from that drop-down select 'modify structure’ which opens the 'Modify table structure' wizard. Ensure you have opened the table structure for the Building Height Attribute data because this is the data we want to create an index on. For the column of data containing the TOID value tick ‘Indexed’ box. Apply this index by pressing ‘Ok’.
7 How do I join the Building Height Attribute csv to OS MasterMap Topography Layer?

In order to use the Building Height Attribute data within a GIS it must first be joined to OS MasterMap Topography Layer. This chapter describes this process for some commonly used GIS.

The .csv data should be loaded into your GIS with the TOID column formatted as it is in your OS MasterMap Topography Layer data holdings (see previous chapters for more details).

A join between these two datasets will link them together based on the unique identifier between the two datasets— the TOID. This will result in the buildings in your OS MasterMap Topography Layer data holdings being associated with a set of building heights.

7.1 ESRI®:

These notes outline how to join Building Height Attribute to OS MasterMap Topography Layer in ArcMap. They have been prepared using version 10.5 of ArcMap. In the procedure describe below, it is assumed that the user has converted OS MasterMap Topography Layer from the .gz supply into an ESRI shapefile format using translation software. It should be noted that Productivity Suite by ESRI will only convert to a Geodatabase format. (see chapter 8). It is also important to ensure that any pre-processing of Building Height Data is completed before commencing an ESRI ArcGIS Session.

Start with the .csv file and the OS MasterMap Topography Layer shapefile loaded into ArcMap.

1 Right click on the Topographic Area Layer in the table of contents, navigate to ‘Joins and Relates’ and select the ‘Join’ option as shown below.

2 In the 'Join Data' wizard that opens first select the .csv file you want to join to the OS MasterMap Topography Layer data from the drop-down under option 2.

For options 1 and 3 select the TOID column in each dataset to specify this as the common attribute between the data that you wish to join on. Lastly, you can choose to keep all records, or keep only matching records; this will mean that you will only have the buildings with heights left after the join.

Select OK to carry out the join—it is better not to choose the ‘Validate Join’ option as this requires a longer processing time.

When you open the attribute table of the layer you have joined the .csv file to you should see the Building Height Attribute columns at the end of the attribute table. You can use the select by attribute tool to display all the buildings in the attribute table to inspect the Building Height Attribute data more easily in ArcMap. If you experience long processing times when querying this join please export the file and then carry out these queries (see step 3 for more details).
Lastly, in order to save this join to the layer, close the attribute table and right click the layer in the table of contents. Select Data > Export Data to save a copy of this shapefile with the Building Height Attribute data joined to it.

Please be aware that large volumes of data may increase the processing time of this step.
Taking too long...

If you are finding that the join process is taking a long time to process you can try an alternative method outlined below which will speed up the join.

Before loading the csv into the GIS you could use ArcCatalog to export the csv table into a Geodatabase (single). When doing this you will have the option to edit the format of the field properties for the TOID data. This will allow you to add an attribute index to the table. Once the index has been added the join process should be quicker. The notes below outline the above steps.

1. Navigate to the csv file in ArcCatalog. Right-hand click on file and select the drop down 'Export' and choose 'To Geodatabase (single)'. This will open up the table to table wizard. Select an output location, which needs to be within a file geodatabase and create a name for the new table you are going to create.

   Finally, in the 'Field Map (optional)' window right hand click on the TOID field and select the ‘Properties’ option which will open the ‘Output Field Properties’ wizard. In the properties box there will be a row called ‘Length’ with a number. This number has to be less than 80 to allow you to add an attribute index later in the process. As TOIDs are never more than 20 characters in length, this number has to be greater than 20, and click ‘Ok’ to close the window. To complete the export select ‘Ok’.

2. Open up ArcGIS and navigate to the Arc Toolbox, select 'Data Management Tools' choose 'Indexes' from the drop down and open the 'Add Attribute Index' tool. Select the table in the File Geodatabase you have just created. In the 'Fields to Index' window and tick the box next to the row which contains the TOID. Select 'Ok' to carry out this operation.

3. Once the index has been added carry out the instructions above to join the Building Height Attribute data to your OS MasterMap Topography Layer data.
7.2 **QGIS:**

These notes outline how to join Building Height Attribute to OS MasterMap Topography Layer in QGIS. They have been prepared using version 2.14.15 of QGIS Desktop.

Start with the `.csv` file and the OS MasterMap Topography Layer data loaded into QGIS.

1. Right click the Topographic Area layer and select ‘Properties’ from the options list. Click the ‘Join’ tab within the ‘Properties’ dialogue box.

2. Press the green plus icon at the bottom of this box and in the dialogue box that opens select the `.csv` file as the ‘Join Layer’.

For the ‘Join Field’ and ‘Target Field’ options select the TOID column in each dataset to specify this as the common attribute between the data you wish to join on. Then select OK and close the ‘Properties’ dialogue box.

When you open the attribute table of the Topographic Area Layer you should see the Building Height Attribute columns at the end of the attribute table. You can use the select features by expression tool to display all the buildings in the attribute table to inspect the Building Height Attribute data more easily in QGIS.
3 Lastly, in order to save this join to the layer, close the attribute table and right click the layer in the table of contents. Select ‘Save as’ from the options list to save a copy of the layer with the Building Height Attribute data joined to it.
7.3 MapInfo®

These notes outline how to join Building Height Attribute to OS MasterMap Topography Layer in MapInfo. They have been prepared using version 12.0.2 of MapInfo.

Start with the .dbf file and the OS MasterMap Topography Layer .TAB file loaded into MapInfo.

1. Select the ‘SQL Select’ button on the ribbon toolbar, and choose the SQL Select option which opens the SQL Select wizard. Leave the ‘*’ in the ‘Select Columns’ box to preserve all fields in both tables.

2. From the ‘Tables’ drop down select the OS MasterMap Topography Layer data and the .dbf file you wish to join. This will populate these tables within the ‘from Tables’ dialogue box.

Click within the ‘where Condition’ dialogue box, and select from the ‘Columns’ drop-down the TOID field from the OS MasterMap Topography Layer data. This will populate this field within the ‘where Condition’ dialogue box.

Enter an equals sign after this column name and then use the ‘Columns’ drop-down to select the TOID field from the .dbf file which will populate this field after the equals sign in the ‘where Condition’ dialogue box.

This has written the SQL query to join these tables via the TOID columns, and should look similar to that shown in the figure above.

In the ‘into Table Named’ box enter the name you wish to call the new table containing both the OS MasterMap Topography Layer data and .dbf file data. Click OK to finish the SQL Select wizard.
A new table will open containing the joined records.

Select the ‘Files’ drop-down from the top toolbar and choose the ‘Save Query’ option to save this join.

If you close the query table and open the version you have saved, a map view of the join will open in a window browser. Please be aware that as you are dealing with large files, these steps may take some time to process.

7.4 Duplicate Records

Users should be aware that in building height data, features are not broken at tile edges. Therefore, once the .CSV files have been merged and then joined with features in the OS MasterMap Topography Layer Topo_Area table, duplicate records will exist in the data. Depending upon which GI application is being used, tools are available within the application to remove duplicate features.

1. **ESRI ARCGIS**
   
   In ArcGIS, use the option ‘Geoprocessing’ > ‘Dissolve’ to remove the duplicate features within the merged data. The output can be saved into file geodatabase, created as described earlier in this chapter.

2. **QGIS**
   
   In QGIS, use the option ‘Vector > Geoprocessing > Dissolve’ to remove the duplicate features within the merged data. The output will be a shapefile containing the de-duplicated data.

3. **MAPINFO Professional**
   
   There are several ways of doing this in MapInfo Professional. One of the ways using SQL queries is described in the MapInfo knowledge base article which can be found here: http://testdrive.mapinfo.com/techsupp/miprod.nsf/kbase_by_product/0E37D7B26ED824168525629900805DD2
8 Importing the Building Height Attribute product into a database

The Building Height Attribute can be loaded into several databases. This chapter describes how to load it into commonly used databases. For more information on other databases that the Building Height Attribute product is compatible with, please speak to your Relationship Manager.

8.1 PostGresSQL

These notes outline how to load Building Height Attribute into a PostGresSQL database using the .csv file you have received. They have been prepared using version 2.0 of PostGIS for PostGresSQL 9.3.

8.1.1 Loading instructions

Open PGAdmin tool (this can be found on the Windows Start Menu – PostGreSQL)

Either connect to an existing database or create a new database

Open the public schema (although in a production environment it is advised to use a different schema) and create the table using the following or similar script:

```sql
create table <Insert table name>(
    OS_TOPO_TOID character varying (20),
    OS_TOPO_TOID_VERSION smallint,
    BHA_ProcessDate date,
    TileRef character varying (6),
    AbsHMin real,
    AbsH2 real,
    AbsHMax real,
    RelH2 real,
    RelHMax real,
    BHA_Conf smallint
);
```

Once the tables have been created, the data can be loaded into the table using the SQL COPY, adding the CSV option as the first line contains a header record.

```sql
COPY <Insert table name> FROM '<Insert file path to bha.csv>' DELIMITER ',' CSV HEADER;
```

Please note: these sections (within the chevrons) require your postGIS table name and the file path to your data which must contain no spaces in the path.
8.1.2 Altering the TOID

The following section details the steps that you can take to reformat the TOID attribute in the Building Height Attribute (BHA) Data you’ve loaded, so that the format matches that of the TOID attribute in your translated OS MasterMap Topography Layer, Topographic Area data.

Please note: If you have used the gawk application process outlined in chapter 6 or the format of the TOIDs in your translated Topography Layer data match that in the BHA, you do not require this step.

Two reformatting options are presented below:

1. **Script to remove 'osgb' from BHA TOIDs:**
   Recommended for use if your translator removes 'osgb' from your Topography Layer TOIDs but does not add any leading zeroes to shorter 13-digit TOIDs.

   Run the following SQL command:
   ```sql
   UPDATE <insert table name> SET <insert TOID column name> = trim('osgb' from os_topo_toid);
   COMMIT;
   ``

2. **Script to remove 'osgb' and add '000' to 13-digit BHA TOIDs:**
   Recommended for use if your translator removes 'osgb' from your Topography Layer TOIDs and adds three leading zeroes to shorter 13-digit TOIDs.

   Run the following SQL command:
   ```sql
   UPDATE <insert table name> set <insert TOID column name> =
   (CASE
   WHEN char_length(<insert TOID column name>) = 20 THEN trim('osgb' from <insert TOID column name>)
   ELSE ('000' || trim('osgb' from <insert TOID column name>))
   END);
   COMMIT;
   ``

Please note: The sections inside the chevrons require your postGIS table name and TOID column name.
8.2 Oracle

The following set of instructions assumes a basic knowledge of Oracle databases and Sabbix which is the package that can be used to load Building Height Attribute CSV into the database. Other options are available for loading data into Oracle databases.

If required copy the data file(s) from the USB stick to an appropriate location. It is worth noting that the file(s) will need to be unzipped and therefore you will need in the region of 1.3 Gb of free space.

Once the data is in an appropriate location the next stage is to uncompress the *.zip file to .csv. This can be done using a package such as Winzip, or 7Zip.

8.2.1 Loading instructions

Create the tables using the SQL below. Prior to running the script the tablespace that the tables are going to reside needs to be altered from `<TablespaceName>` to the tablespace that is being worked in.

If the table already exists you will firstly need to drop the table using the following SQL:

```
DROP TABLE <Insert Table Name> CASCADE CONSTRAINTS;
```

Now you will need to create a new empty table using the following SQL:

```
CREATE TABLE <Insert Table Name>
(
    MI_PRINX NUMBER (38, 0),
    OS_TOPO_TOID VARCHAR2 (20),
    OS_TOPO_VERSION NUMBER,
    BHA_PROCESSDATE DATE,
    TILEREF VARCHAR2 (6),
    ABSHMIN FLOAT,
    ABSH2 FLOAT,
    ABSHMAX FLOAT,
    RELH2 FLOAT,
    RELHMAX FLOAT,
    BHA_CONF NUMBER
);
```

```
DROP SEQUENCE BHA_data_S;
CREATE SEQUENCE BHA_data_S
START WITH 1
INCREMENT BY 1;
COMMIT;
```
Create an SQUILDR control file containing the following information:

OPTIONS(SKIP=1, BINDSIZE=20971520, READSIZE=20971520, ROWS=2500, ERRORS=10, SILENT=FEEDBACK)

LOAD DATA
CHARACTERSET WE8ISO859P1
INFILE '<Insert file path to bha.csv>'

APPEND

INTO TABLE BHA_data

FIELDS TERMINATED BY """
OPTIONALLY ENCLOSED BY """
TRAILING NULLCOLS

MI_PRINX EXPRESSION "BHA_data_S.NEXTVAL",
OS_TOPO_TOID,
OS_TOPO_VERSION,
BHA_PROCESSDATE DATE "YYYY-MM-DD",
TILEREF,
ABSHMIN,
ABSH2,
ABSHMAX,
RELH2,
RELHMAX,
BHA_CONF

Please note: these sections require your table name and the file path to your data which must contain no spaces in the file path.

Once this file is created it can be called from a .bat file to run on the box that holds the database rather than a remote machine. The contents of the .bat file should be similar to:

@sqlldr <username>/ <password>@ <service name> control= <name of ctl file created previously>
Pause

'Double click' the .bat file that you've just created to load the data into the BHA_DATA table in your database.
8.2.2 Altering the TOID

**Please note:** If you have used the gawk application process outlined in chapter 6 or the format of the TOIDs in your translated Topography Layer data match that in the BHA, you do not require this step.

Two reformatting options are presented below:

1. **Script to remove 'osgb' from BHA TOIDs:**
   Recommended for use if your translator removes 'osgb' from your Topography Layer TOIDs but does not add any leading zeroes to shorter 13-digit TOIDs.
   
   Run the following SQL command:
   
   ```sql
   UPDATE <Insert Table Name> set <Insert Table Name>.<insert TOID column name>=substr(<Insert Table Name>.<insert TOID column name>, 5);
   ```

2. **Script to remove 'osgb' and add '000' to 13-digit BHA TOIDs:**
   Recommended for use if your translator removes 'osgb' from your Topography Layer TOIDs and adds three leading zeroes to shorter 13-digit TOIDs.
   
   Run the following SQL command:
   
   ```sql
   UPDATE <Insert Table Name> set <Insert Table Name>.<insert TOID column name>=(CASE WHEN length(os_topo_toid) = 20 then substr(<Insert Table Name>.<insert TOID column name>, 5)
   ELSE ('000' || substr(<Insert Table Name>.<insert TOID column name>, 5))
   END);
   ```

   **Please note:** The sections inside the chevrons require your table name and TOID column name.
9 Further information

Further information about the Building Height Attribute can be found on the Ordnance Survey website.


Further information can be found about the Building Height Attribute in Annexe D of the Topography Layer User Guide and Annexe E of the Technical Specification which can be found on the Ordnance Survey website.

http://www.ordnancesurvey.co.uk/docs/user-guides/os-mastermap-topography-layer-user-guide.pdf

A coverage map for the Building Height Attribute can be found on the Ordnance Survey website.
